Application of Excel® Pivot Tables and Pivot Charts for Efficient Library Data Analysis and Illustration

Andrea Miller
Missouri State University

Follow this and additional works at: https://bearworks.missouristate.edu/articles-lib
Part of the Collection Development and Management Commons

Recommended Citation

This article or document was made available through BearWorks, the institutional repository of Missouri State University. The work contained in it may be protected by copyright and require permission of the copyright holder for reuse or redistribution.
For more information, please contact BearWorks@library.missouristate.edu.
Application of Excel® Pivot Tables and Pivot Charts

for Efficient Library Data Analysis and Illustration

Author Note

Andrea Miller, Duane G. Meyer Library, Missouri State University.

Correspondence concerning this article should be addressed to Andrea Miller, Duane G. Meyer Library, Missouri State University, 901 S. National Ave., Springfield, MO 65897. E-mail: AndreaMiller@MissouriState.edu
Abstract. Excel® pivot tables and pivot charts are ideal tools for increasing efficiency in previously time-consuming tasks involved in the analysis of library data, such as electronic resource usage statistics. Building upon the background presented in an introductory article, this companion article continues with information concerning essential techniques and applications. Data must be properly formatted in preparation for its use with pivot tables and pivot charts. Steps in the creation of both pivot tables and pivot charts are detailed along with potential pitfalls. Best practices are covered with specific tips for ensuring accurate results.

Keywords: Excel® PivotTables, Excel® PivotCharts, pivot tables, pivot charts, library data analysis, library data illustration

Author Note
Andrea Miller, Duane G. Meyer Library, Missouri State University.
Correspondence concerning this article should be addressed to Andrea Miller, Duane G. Meyer Library, Missouri State University, 901 S. National Ave., Springfield, MO 65897. E-mail: AndreaMiller@MissouriState.edu

Received: November 13, 2013
Accepted: December 12, 2013
Pivot tables and pivot charts in Excel® can dramatically ease the task of data analysis for librarians. Pivot tables and pivot charts are powerful tools that markedly increase efficiency in data analysis and illustration. Complex data may be effortlessly arrayed into manageable components, and visual representations can be created to further elucidate the data. The data being examined is rendered considerably more flexible so ad hoc questions that arise about the data can be readily answered.

The time and effort saving capabilities of pivot tables and pivot charts were presented in an introductory article, along with suggested approaches for their use and a review of the literature (Miller, 2014). This companion article will concern itself with the application of essential techniques and concepts. Information will be presented on how to create and use pivot tables and pivot charts, and will use electronic resource statistics as a basis for conducting analysis. Topics to be covered will include preparing and formatting the source data, properly creating pivot tables and pivot charts, and best practices to follow for optimal results.

**Preparation of the Data**

This section will describe the steps involved in creating a pivot table in Excel® 2010. Sample data used in the illustrations is available to download for experimentation at [http://people.missouristate.edu/andreamiller/PivotTables3.htm](http://people.missouristate.edu/andreamiller/PivotTables3.htm). The data consists of electronic resource accesses or “hits.” The Collection Development & Acquisitions Department of Missouri State University collects the number of hits on the library’s permanent URLs (PURLs) on the day of commencement ceremonies three times a year.
Each electronic resource has been assigned an abbreviation resembling a fund code. The abbreviations label the electronic resource as either a general resource or as being associated with one of the university’s six colleges. As with learning any new process, it is advisable to practice upon a duplicate copy of the original data. The learner may then freely experiment with the duplicate copy of the data until the process is mastered.

The data used to create pivot tables and pivot charts is referred to as source data. The first step is to format the source data for optimal performance. Source data must possess certain characteristics to work properly in pivot tables and pivot charts. All columns must have a heading, and each column heading must be unique. Any empty rows and blank columns, including any that may be hidden, must be deleted. Each column should have only a single type of data in it, such as only text or only consistently formatted numbers concerning only one topic, or category, of data. No subtotals or grand totals should be included. In short, the data must be in a unified columnar or tabular format.

Figure 1 depicts an example of a data layout that is inappropriate for use with pivot tables. A number of reconfigurations need to be made to the data before it can be used to create a pivot table or pivot chart. Blank rows and columns, such as column B and rows 7 and 13, must be removed. Instead of having its own data-type column with the category of semester as the heading and the data elements being either spring, summer, or fall, the semesters are inappropriately split across several columns and rows (D3:F3, D9:F9, and D15:F15). Designs in which units of time (semesters, months, years) or names are spread out across columns are not practical for pivot tables. Difficulty arises because the units of time are both column headings and also data elements that may be objects of inquiry. The
data needs to be reformatted so spring, summer, and fall are data elements in a single column with the category of “Semester” as its column heading. Blank cells such as A4:A6 are assumed to signify PsycINFO (GEN), but such blank cells should contain the actual data. In addition, Column A holds both the title of the electronic resource (PsycINFO) and the college (CHHS) to which it is assigned, which results in two different categories of data in a single cell. The different categories of data need to be separated into individual columns. One column should contain only the titles of the electronic resources. The other should contain only the college assignment for that electronic resource. Delete any rows or columns containing subtotals and grand totals. Correct totals and subtotals will be automatically created in the appropriate areas by the pivot table. If a grand total must be retained in the source data, the grand total has to be manually excluded from the range surrounded by the scrolling marquee used to create the pivot table. If this is not done, the grand total will be treated as a data element along with the rest of the rows. Imprudently, the data was merely entered into a spreadsheet as ranges in a shape resembling a table. Instead, the data should be converted from ranges into an expressly formatted regular table (see Method of Creating Regular Excel® Tables section).

Figure 2 illustrates a corrected version of the data from Figure 1. It is now in a unified tabular format ready for use with pivot tables. Each column has a unique heading and contains a single category of data. There are no blank rows or columns, and every cell contains data. Semesters are now contained within their own category column. No totals are included. The data has been changed from ranges that were simply typed into the shape of a table into a deliberately formatted regular table with additional functionality.
A simple copying function can make the process of filling in identical data that is repeated, such as a year or a semester, very efficient. Manually filling a column with data by grabbing the fill handle square in the bottom right corner of the cell to be repeated and dragging the fill handle down the column is tedious. It is tiresome if there are hundreds or even thousands of rows to fill, and it is easy to accidentally drag the fill handle well past the end of the data. Such problems are solved by selecting the cell (or cells) to be repeated and double-clicking on the fill handle square in the lower right corner of the cell (see Figure 3). The cell’s value will be automatically repeated down the length of the column as long as there is some data adjacent to the cells on the left or the right. Note that in versions earlier than Excel® 2010, Excel® will stop automatically filling in the repeated data if a blank cell is present in the adjacent data.

Blank cells in columns can sometimes cause problems or errors with the pivot table analysis of the data. For example, a blank cell may cause data in that column to be treated as text rather than as numeric. Consequently, it may cause the pivot table to produce a count rather than a sum of the data. To help avoid such annoyances, zeros should be inserted into any blank cells in the source data when it is feasible to do so. It is possible to automate the process of inserting a zero into all blank cells by using the find and replace function (keyboard shortcut: Ctrl + H). In the Find and Replace dialog box, leave the “Find what:” field blank, type a zero into the “Replace with:” field, and click the Replace All button. Note, however, that this time-saving technique will not work if the space bar has been tapped in an otherwise empty cell. Although the space is invisible, Excel®
perceives the cell not to be empty because it contains a space and will not insert a zero into the cell. Overcome this difficulty by entering a space into the “Find what:” field and methodically going through the spreadsheet with the Find Next button. Searching for a space will result in false leads due to spaces between words; however, it will find empty cells with invisible spaces which can then have a zero inserted manually. If the decision is made to not fill in blank cells with zeros, then definitely double-check for any unexpected results that may arise.

If the pivot table’s results produce a count of numerical data rather than a sum, the column in the source data probably contains at least one blank cell or contains text (excluding the header cell) rather than a number. In the source data, replace the blank with a zero or the text with an appropriate number, and then refresh (see Best Practices section for proper technique) the pivot table. To bypass this process, right-click on the cell that reads Count of Hits, click on Value Field Settings in the drop-down, and in the Summarize Values By tab, select Sum instead of Count and click OK. Averages, minimum (smallest) numbers, maximum (largest) numbers, and other functions may also be selected, if so desired. These functions provide means to answer such questions as which electronic resource had the most (max) or fewest (min) hits, or which electronic resource cost the most or the least if pricing information is included.

**Method of Creating Regular Excel® Tables**

It is advisable to format the source data as a regular table before creating the pivot table. Formatting the source data as a table will not only help correctly identify the desired range of data to be used, but it also will ensure the proper incorporation of any new data. As part of their additional functionality, tables will automatically expand their
range to incorporate any future data added within them or adjacent to them. If the data has not been formatted as a table, any newly added data, such as additional rows appended to the bottom of the existing data, will likely not be incorporated into the source data used to create the pivot table. Furthermore, the refresh command will likely not incorporate the new data, thus leaving the pivot table with the same old data rather than being truly refreshed with the infusion of the new data.

To convert the initial data into a regular table, click on any cell within the source data. On the Insert tab, click the Table icon (keyboard shortcut: Ctrl + T) pictured in Figure 4. Ascertain that the suggested range of data in the ensuing dialog box is correct, leave the checkmark in the box indicating that the table has headers, and click OK. A newly formatted table will be created, and a new Design tab will appear in a yellow highlighted Table Tools area of the Ribbon. A generic Table Name will automatically appear in the Properties section on the far left of the Design tab, and the generic table name may be retained or changed to a specific name as desired.

[place figure 4 here]

**Method of Creating Pivot Tables**

The next step after standardizing the source data is to begin the creation of the pivot table. To turn a table into a pivot table, click on a cell anywhere within the source data, which ideally has been formatted as a regular Excel® table as described above instead of being left as a typical range of data that was simply typed into the shape of a table. Click on the Insert tab in the Ribbon. At the far left, locate the icon labeled PivotTable as illustrated in Figure 4. Either click on the icon itself or click on the small down arrow underneath the label and choose PivotTable in the drop-down list that appears.
The Create PivotTable dialog box will appear, requiring two different choices. The first choice is “Choose the data that you want to analyze.” The first radio button option, which is automatically selected as the default, is to “Select a table or range.” This default setting automatically identifies the Table/Range in which the source data resides and supplies the name of the source-data table or the location of the cell range of source data if it was not converted into a table. It is a good practice, especially if the source data was not formatted as a table, to double-check that Excel® has actually selected the entirety of the correct data (including the headings) by visually examining the parameters of the moving marquee that automatically appeared around the data.

Be aware during the double-checking process that clicking in any cell will alter the selected range by changing its coordinates and, by extension, the moving marquee. Such clicking in other cells should generally be avoided because Excel® usually selects the correct range of data. Even so, there may be instances in which the user desires a different range of data, such as only a portion of the source data. In a case like this, deliberately clicking in the desired cells to narrow the selection to the preferred data would be an appropriate action. The same result may be better achieved, however, by applying filters to a pivot table based upon the entire source data. The second radio button option for choosing the data to be analyzed is “Use an external data source.” The user may choose to browse and retrieve data from external sources such as other Excel® files, databases such as Microsoft Access and SQL Server, or an Online Analytical Processing (OLAP) cube.

The second choice in the Create PivotTable dialog box is “Choose where you want the PivotTable report to be placed.” The first radio button option, New Worksheet, is the
default. This will place the pivot table in a new worksheet within the same workbook, and it will appear to the left of Sheet 1. The second radio button option, Existing Worksheet, offers the option of placing the pivot table on the same worksheet as the source data. If this option is chosen, the user must identify a cell in which to locate the pivot table by clicking on the desired cell, such as in the empty area to the right of the source data. After the desired radio buttons have been selected in the Create PivotTable dialog box, click the OK button.

The framework for the pivot table will appear in the chosen location. A new pink section of PivotTable Tools with Options and Design tabs appears in the Ribbon when a pivot table is created, or when the cursor is in a pivot table, making it the active area of the worksheet. The location chosen for the pivot table will at first have no data in it. Figure 5 illustrates a pivot table that has already had data added into it, according to the process which follows. The next step is to build the PivotTable report by choosing fields from the PivotTable Field List, which is a large dialog box that will appear on the far right side of the window. The PivotTable Field List dialog box also appears whenever the user clicks inside the pivot table. If the user clicks in a cell outside of the pivot table, the PivotTable Field List will disappear. To make the list visible again, click on any cell within the pivot table. If the user has purposely closed the PivotTable Field List dialog box by clicking the “x” in its upper right-hand corner, the field list will not reappear until the user clicks on a cell within the pivot table, selects the Options tab in the PivotTable Tools area highlighted in pink in the Ribbon, finds the Show group on the far right, and clicks on Field List.

[place figure 5 here]
By default, the PivotTable Field List dialog box features a large rectangle at the top containing fields with four smaller rectangles, known as areas, below it. The default view will be assumed in this article. If desired, this default view can be changed by clicking on the small button in the upper right-hand side of the rectangle and selecting a different view from the choices that appear in the drop-down. The large rectangle is labeled with the header “Choose fields to add to report,” and it should contain a list of the column headers originally found in the source data, with checkboxes to the left of each.

In the PivotTable Field List dialog box, directly below the large rectangle containing the fields are four smaller rectangles under the header “Drag fields between areas below.” The field names in the large rectangle may be dragged and dropped into these four smaller rectangles, or areas. These areas correspond to specific sections of the pivot table. These four areas have the headers Report Filter, Column Labels, Row Labels, and Values, and can be described as follows.

- **Report Filter**: This upper left area places the field in the section of the pivot table that permits filtering of the entire pivot-table report. Only the filtered data will be displayed. This area is an optional area and may not always be used, but it can be helpful to use as a control for isolating specific aspects of the data. Use the checkbox in the drop-down to filter multiple variables.

- **Column Labels**: This upper right area will place the fields across the top of the pivot table as column labels. This area is useful for detecting data trends or viewing data side by side.
• Row Labels: This lower left area will place the fields down the left side of the pivot table as row labels. This area is useful for data that is to be grouped and categorized.

• Values: This lower right area will populate the body of the pivot table next to and under the row and column labels. This area should contain the data to be summarized, and calculations may be performed on it.

Deciding on the appropriate area for each field might appear to be a daunting challenge, but planning the appropriate location for fields in advance is not actually necessary. Satisfactory arrangements can often be discovered through a process of trial and error. Before attempting to place the fields, it is helpful to reflect on what sort of information is in the source data and what needs to be known about it. The information to be measured will determine which fields should be used. It is not necessary to place all of the fields from the field list in the large rectangle into the four areas in the small rectangles. Only the fields of interest are needed, and this may or may not include all of the fields at once. One advantage of pivot tables is that many different combinations of the fields of interest can easily be created one after the other, thereby quickly viewing different aspects of the data.

The next point to contemplate is the desired arrangement of the data in the resulting pivot table, which will suggest the areas in which the fields should be placed. For example, the contents of column A in the source data may be desired as column headers in the pivot table and will consequently be placed in the Column Labels area. Data that lends itself well to Row Labels and Column Labels areas is usually of a discrete nature. This type of data has a countable number of defined categories. Examples might be that
the data is one of a finite number of electronic resource title names, a certain year, or one of four quarters. The Values area generally contains open-ended data that could have virtually any value. Examples would be the number of hits on an electronic resource, prices, or the number of electronic books added each year.

Any uncertainty regarding which fields to place in which areas should not be a significant concern. The pivot table creation process lends itself well to experimentation. Perseverance through possible confusion in the beginning will be well rewarded once understanding is achieved through exposure and experimentation. As fields from the PivotTable Field List are placed in the various areas, they will begin to populate the pivot table itself. Experimenting with arranging fields in various areas will usually produce a combination that creates a pivot table that makes sense. In addition to the placement of the fields in different areas, the order of multiple fields within a single area also makes a difference. When multiple fields are in an area, experiment with rearranging the order of the fields by dragging and dropping them. If a certain field is above another field, drag the top field to the bottom so the field originally underneath it is now above it. Excel® can automatically place fields into default areas based on the field’s data type if a checkmark is placed in the box to the left of the field name. Excel® will automatically place OLAP time and date hierarchies in the Column Labels area, text fields will be placed in the Row Labels area, and numeric fields will be placed in the Values area. Remember that an empty cell in the source data may cause the data to be treated as a text field rather than a numeric field. The automated arrangement may or may not suit the user’s information and summarization needs, and further experimentation may be needed. After viewing the
automated results, the user can continue to experiment with rearranging the fields as described above so as to create a more meaningful layout of the data.

Depending on the nature and arrangement of the data used to construct the pivot table, the user may notice various features that have been automatically added to the resulting pivot table. There may be subtotals and/or grand totals that have been automatically calculated for various groupings within the data and for the group as a whole. Constructing a similar layout by hand would be a longer process, whereas a pivot table creates these subtotals and grand totals in a matter of seconds. There may be a small +/- icon to the left of grouping headings in the rows, denoting a hierarchical structure within the totaling. This +/- icon can be clicked manually to show or hide the subgroup of data beneath the grouping’s heading. Alternatively, all of the +/- icons at the same level within the hierarchy can be simultaneously expanded or collapsed through command buttons.

Place the cursor in one of the cells containing a +/- icon. In the Ribbon under the options tab in the pink PivotTable Tools area, find the Active Field grouping, and to the right of “Active Field:” click on the green plus sign for Expand Entire Field or on the red minus sign for Collapse Entire Field. The pivot table may be very interesting and helpful in and of itself, especially as more and more data across a span of time or other unit of measurement or comparison is added.

If certain subcategories are not needed, those can be removed through filtering. For example, click on the small drop-down arrow at the far right end of a cell with a heading, such as the Row Labels. Use the Select Field drop-down box that appears at the very top to choose a field to be filtered. Then select or deselect the checkmark boxes next to the fields at the bottom of the drop-down menu to filter only those items. After at least one of
the checkmark boxes has been deselected and verified by clicking the OK button, the
original small drop-down arrow at the far right end of the cell with the heading will
change to a picture of a funnel-shaped filter next to an even smaller arrow. This filter
icon is a reminder that not all of the data available below that heading is visible because a
filter has been applied. Filters that have been applied are not always easily discerned by
merely looking at the pivot table. To more easily review which filters have been applied,
the user should look for the filter icon in the PivotTable Field List dialog box. Clicking
on the filter icon in the large rectangle at the top of the PivotTable Field List containing
the fields will reveal the fields that have been filtered and will also provide the
opportunity for additional filtering by selecting or deselecting the checkmark boxes for
those fields.

Double-clicking on any cell in the pivot table will open a new worksheet that reveals
the data that was used to produce the value that is contained in that cell. This ability can
be especially convenient for cells that contain summarized data, such as subtotals or
grand totals. The newly created worksheet is only a source of information; it is not
dynamically linked with any other worksheets. Any changes made in the new worksheet
do not affect either the pivot table or the source data, and vice versa. Anyone can double-
click to reveal the data that was used to create a summarized value, even if the pivot table
is copied into a new Excel® workbook. If privacy of the underlying data is a concern,
distribute an image of the pivot table rather than the pivot table itself.

**Pivot Charts**

Pictures can be worth a thousand words, especially when illustrating numerical data.
Pivot charts are a simple tool for transforming the source data contained in pivot tables
into readily understood illustrations. Data that may require much time and thought to analyze and interpret when presented in a table may be immediately comprehended when presented in a visual format. Relationships and proportions become instantly obvious when seen in graphic form. The pivot chart can make use of all of the source data available to the pivot table, and just as in the pivot table, that data can be rearranged and filtered as desired. The pivot chart dynamically changes in tandem with the pivot table when filters are applied to it and vice versa.

**Method of Creating Pivot Charts**

This section will set forth the steps that may be used to create a pivot chart in Excel\textsuperscript{©} 2010. The pivot chart will illustrate the pivot table created previously, based upon properly prepared and formatted source data.

Begin the process of creating a pivot chart by starting with a pivot table that has had no filters applied to it. To create a pivot chart, click anywhere inside the pivot table. In the Insert tab on the Ribbon, locate the Charts group, and choose the desired chart type. For demonstration purposes, choose a columnar chart type by clicking on the Column icon. In the drop-down menu of choices, find the 2-D Column section at the top and click on the center option Stacked Column, which features two bi-colored columns of unequal height. A pivot chart illustrating the data will immediately appear on the same worksheet as the pivot table as pictured in Figure 6.

[place figure 6 here]

As a default, a newly created pivot chart appears as an object in the same worksheet as the pivot table it is based upon. The pivot chart can be moved to a different worksheet by right-clicking on a blank area inside the chart, well away from the box-like plot areas
containing the data. In the drop-down menu that appears, click on “Move Chart…” A
Move Chart dialog box will appear, soliciting a choice of where the chart is to be placed. Select the radio button for “New sheet” and consider the option of giving the new sheet a more meaningful name than the default Chart 1. Click OK to move the pivot chart to the newly created sheet. Alternatively, in the Move Chart dialog box, select the radio button for “Object in,” and select a pre-existing worksheet from the drop-down menu. The pivot chart can be resized. If the pivot chart seems small and does not seem to illustrate all the expected data, grab onto its margins and enlarge the size of the chart to determine if a small opening frame size is concealing part of the data. Any grand totals or subtotals that appear in the pivot table are not included in the pivot chart. If any filters were applied to the pivot table, it will cause the data presented in the pivot chart to be filtered as well.

Just as in pivot tables, filters can be applied to the resulting chart in order to generate many different views of the data. Recall that when filters are applied to a pivot chart, the same filter is instantly applied to its corresponding pivot table and vice versa. The instantaneous changes wrought by filtering should not be confused with true changes to the original source data, which require proper refreshing technique in order to incorporate these changes into both pivot tables and pivot charts.

Two of the area names, which were discussed as part of the creation of pivot tables, have different names in pivot charts. Column Labels in pivot tables are instead known as Legend Fields in pivot charts, and Row Labels in pivot tables are instead called Axis Fields in pivot charts. Furthermore, if the pivot chart does not seem to make sense, consider that the fields may need to be moved to a different area than that in which they made the most sense when viewed as a pivot table. The data in the Column Labels area of
a pivot table will appear on the y-axis of a pivot chart, and the data in the Row Labels area will appear on the x-axis.

When a pivot chart is first created or when a pivot chart is clicked upon making it the active area of the worksheet, a new, green section of PivotChart Tools with Design, Layout, Format, and Analyze tabs emerges in the Ribbon. The layout of the chart can be changed to achieve different looks and views of the data. Many additional refinements are possible. The same caveats apply to pivot charts as well as pivot tables, such as the need to properly refresh (see Best Practices section) in order to incorporate newly added source data.

The gray buttons that appear within a pivot chart are called field buttons, and they correspond to the fields in the large rectangle in the PivotTable Field List. The presence of a down arrow on the far right end of the button indicates that it contains a drop-down menu that can be used to perform various sorts of the data and to apply filters. The gray buttons can be removed for aesthetic purposes by clicking in the pivot chart to activate the green PivotChart Tools section of the Ribbon, selecting the Analyze tab, locating the Show/Hide group, clicking on the down arrow next to Field Buttons, and hiding all or deselecting the undesired buttons.

**Best Practices**

In addition to the tips already mentioned, following a number of best practices can help assure that data analysis results will be as desired. The pivot tables should always be scanned to confirm that the data looks as expected. Problems may sometimes arise. Extraneous row labels may be present due to misspellings, such as a misspelled college abbreviation that is treated as its own unique entity. An extra tap on the space bar which
creates an extra space after the last character of an entry in a cell may cause Excel® to perceive the data in that cell as a different value from other cells that contain the exact same text but have no extraneous space after the last character. All problems detected must be corrected in the source data; data cannot be changed from within a pivot table or pivot chart. After correcting the source data, the pivot table must be refreshed (see below) to ensure the problems will not persist. If it is not refreshed properly, the original problem may remain. Care must be taken when adding additional data to the source data. If a new row (or rows) of data is inserted between existing rows of data, everything should continue to operate as expected. If more data is added underneath or beside existing data, perform a double check to ensure the pivot table range has incorporated the new data within the moving marquee. The new data may not have been assimilated if the source data was left as a range instead of being made into a regular table. If, as was previously suggested, the source data was expressly formatted as a regular table before beginning the creation of the pivot table, the new data should appear within the moving marquee since tables automatically incorporate any additional data added underneath or beside them. The pivot table can then be refreshed so the new information in the source data will in turn be incorporated into the pivot table.

**Pivot Cache and Refreshing Data**

Creating a pivot table causes a pivot cache to be created as well. The pivot cache is a copy of the source data that is stored in memory and is used to accelerate operations. The pivot table is therefore detached from its source data. If any changes are made to the source data, the changes are not automatically replicated or recalculated in the pivot table. The user must refresh the pivot table, or more accurately the pivot cache, in order
to incorporate the changes into the pivot table. To refresh a pivot table, either right-click on the pivot table itself and click Refresh on the drop-down menu that appears, or click on the Options tab in the pink PivotTable Tools area of the Ribbon and click the Refresh button in the Data grouping. To refresh a pivot chart, click on the Analyze tab in the green PivotChart Tools area of the Ribbon and click the Refresh button. If the pivot table does not seem to contain the new data after correctly refreshing it, the source data was probably not initially formatted as a regular table that automatically incorporates any new data added beneath or beside it. Hence, the moving marquee range in the source data used as the basis for the pivot table likely still encompasses only the original data and did not expand to include the newly added data. To manually expand the range to include the new data, click anywhere in the pivot table, click on the Options tab in the pink PivotTable Tools area of the Ribbon, click Change Source Data in the Data grouping, and adjust the coordinates of the range. Alternatively, start over completely and convert the source data into a regular table, create a new pivot table, and refresh the pivot table each time new data is added to the source data.

Since the pivot cache is a copy of the source data, it uses memory and therefore increases the file size. Excel® will create a new pivot cache, and consequently increase the file size, each time a new separate pivot table is created, even if it is based on source data that has already produced a pivot cache. If a user plans to create additional pivot tables, for example on separate worksheets, to document various views of the same source data, it is best to copy and paste the original pivot table and then manipulate the copy to create a new view of the data in order to minimize file size. To copy a pivot table, click anywhere inside of it. In the PivotTable Tools area of the Ribbon, go to the Options
tab, then the Actions group, then click the small down arrow by the word Select, click on Entire PivotTable, then copy and paste it where desired. Click the Refresh button in the Options tab to replicate the entire look, such as column widths, of the original. The copy may be freely changed to document new views of the data.

**Conclusion**

Once an understanding of the fundamental workings of pivot tables and pivot charts is achieved through practice, the user will begin to envision numerous applications for the techniques. Previously time-consuming analyses may now be performed rapidly, with a corresponding boost in productivity. Even massive amounts of data can be summarized in any number of arrangements within seconds.

Pivot tables and pivot charts are well worth the investment in time spent learning proper techniques for their employment. Diligent preparation of the source data provides a firm foundation upon which pivot tables and pivot charts can be swiftly built. Librarians should seek to master the use of pivot tables and pivot charts in order to dramatically enhance their ability to analyze data with Excel®.
References


Figure Captions

**Figure 1.** Inappropriate data layout for pivoting.

**Figure 2.** Standardized data layout for pivoting.

**Figure 3.** Quick fill handle.

**Figure 4.** PivotTable icon and regular table icon.

**Figure 5.** Example pivot table.

**Figure 6.** Pivot chart example.
Figure 1. Inappropriate data layout for pivoting.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td><strong>Title &amp; College</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PsycINFO (CHHS)</td>
<td></td>
<td>Year</td>
<td>Spring</td>
<td>Summer</td>
<td>Fall</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>2006</td>
<td>6070</td>
<td>1277</td>
<td>6501</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td>2007</td>
<td>5536</td>
<td>1273</td>
<td>5718</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td>2008</td>
<td>5107</td>
<td>1221</td>
<td>4761</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>SPORTDiscus (CHHS)</td>
<td></td>
<td>Year</td>
<td>Spring</td>
<td>Summer</td>
<td>Fall</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td>2006</td>
<td>520</td>
<td>115</td>
<td>364</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td>2007</td>
<td>292</td>
<td>37</td>
<td>352</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td>2008</td>
<td>240</td>
<td>81</td>
<td>297</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Academic Search Premier (GEN)</td>
<td></td>
<td>Year</td>
<td>Spring</td>
<td>Summer</td>
<td>Fall</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td>2006</td>
<td>16915</td>
<td>3333</td>
<td>23732</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td>2007</td>
<td>14969</td>
<td>3412</td>
<td>22614</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td>2008</td>
<td>16673</td>
<td>3612</td>
<td>26322</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Figure 2. Standardized data layout for pivoting.

<table>
<thead>
<tr>
<th>Title</th>
<th>College</th>
<th>Hits</th>
<th>Year</th>
<th>Semester</th>
</tr>
</thead>
<tbody>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>6,070</td>
<td>2006</td>
<td>Spring</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>520</td>
<td>2006</td>
<td>Spring</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>16,915</td>
<td>2006</td>
<td>Spring</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>1,277</td>
<td>2006</td>
<td>Summer</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>115</td>
<td>2006</td>
<td>Summer</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>3,333</td>
<td>2006</td>
<td>Summer</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>6,501</td>
<td>2006</td>
<td>Fall</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>364</td>
<td>2006</td>
<td>Fall</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>23,732</td>
<td>2006</td>
<td>Fall</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>5,536</td>
<td>2007</td>
<td>Spring</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>292</td>
<td>2007</td>
<td>Spring</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>14,969</td>
<td>2007</td>
<td>Spring</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>1,273</td>
<td>2007</td>
<td>Summer</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>37</td>
<td>2007</td>
<td>Summer</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>3,412</td>
<td>2007</td>
<td>Summer</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>5,718</td>
<td>2007</td>
<td>Fall</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>352</td>
<td>2007</td>
<td>Fall</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>22,614</td>
<td>2007</td>
<td>Fall</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>5,107</td>
<td>2008</td>
<td>Spring</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>240</td>
<td>2008</td>
<td>Spring</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>16,673</td>
<td>2008</td>
<td>Spring</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>1,221</td>
<td>2008</td>
<td>Summer</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>81</td>
<td>2008</td>
<td>Summer</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>3,612</td>
<td>2008</td>
<td>Summer</td>
</tr>
<tr>
<td>PsycINFO</td>
<td>CHHS</td>
<td>4,761</td>
<td>2008</td>
<td>Fall</td>
</tr>
<tr>
<td>SPORTDiscus</td>
<td>CHHS</td>
<td>297</td>
<td>2008</td>
<td>Fall</td>
</tr>
<tr>
<td>Academic Search Premier</td>
<td>GEN</td>
<td>26,322</td>
<td>2008</td>
<td>Fall</td>
</tr>
</tbody>
</table>
Figure 3. Quick fill handle.
**Figure 4.** PivotTable icon and regular table icon.
Figure 5. Example pivot table.
Figure 6. Pivot chart example.